Inspiration® 8.0 20 Minute Presentation
Fall 2007
I.

Welcome to the Inspiration® 8 20-Minute Presentation guide! Developed by Inspiration
Software®, Inc., this guide is designed to walk you through a 20-minute presentation on
Inspiration 8, the essential tool to help students grades 6 to adult visualize, think, organize and
learn.
This guide assumes a moderate degree of experience with Inspiration. Please use the Inspiration
Getting Started Guide to familiarize yourself with the features and uses of Inspiration. You may
access this guide via the Inspiration Starter screen by selecting Learn to Use and then finding it under
Documentation.
To download a free, 30-day trial of Inspiration visit www.inspiration.com/freetrial. Downloading
Inspiration 8 will not interfere with any previous Inspiration files.
Feel free to modify this guide as needed depending upon your audience and the length of your
session. If you have any questions as you prepare for your presentation, or if you would like to
receive materials including our Inspiration Software® Evaluation CD to share with those you are
training, please contact our Training Resources Department at trainingresources@inspiration.com.

II.

Presentation Preparation
A.

Make sure the audio is turned on prior to the presentation (important for the video clip
demonstration).

B.

Make sure Symbol Palette is not showing at beginning of presentation.
(Note: If you will not have an Internet connection during your presentation, you will need to
create a custom symbol library in order to perform the symbol search required in section V. B. 5.
below. To do so, you will need to copy the Money symbol library.inl library file into the
Libraries folder, which is within the Inspiration 8 application folder on your hard drive. If you
would prefer that the library be in its own category within the Symbol Palette, you can create a
folder called something like "Workshop Libraries" and put the library within it. Then, you can
move it into the Libraries folder on your hard drive, as specified above.)

C.

If you will not have a fast Internet connection during your presentation, download the
Curriculum Packet onto presentation computer (Acids and Bases curriculum pack folder
and Acids and Bases Unit.isf).
The folder includes the Acids and Bases Unit.isf diagram and its associated templates and

exemplars. Make sure the folder's contents have been downloaded onto your presentation
computer and saved here (C:\Program Files\Inspiration 8\Learn to Use\Curriculum Packets) so
you may access the files from the Learn to Use section easily. Also make sure the hyperlinks to
the associated templates and exemplars are working.
D.

General note: Upon returning to any diagram, make sure the whole diagram is showing
(centered) on the screen by doing a Control-E (or Command-E on a Mac).

E.

Examples & Templates
Open all examples and templates used in the script and ensure they are ready to display. When
you open each example, make sure that the symbols are correct, the colors look good and the
diagrams are centered on the screen unless otherwise noted. Use Revert to Saved on the File
menu if you make any changes to any of the diagrams. Be sure each example was saved correctly
to open to the correct levels.
Make sure to open files in exactly the following order to show files in the best way.
1. Inspiration positioning document
You will open the Inspiration positioning diagram at the introduction and conclusion
sections of the presentation.
2. Blank.isf
3. Ozone
This file should be save with View/Quick Controls/Always Show selected, and everything
below Bad Ozone and Good Ozone collapsed. Quick controls (hide/show) for all yellow
symbols under Bad Ozone should be saved as open. Environment and Human Health
Quick Controls (hide/show) are saved closed. Note to speakers about Ozone and Science
Fair examples: The reason for revealing sections of these documents one at a time is to make
it easier for audience to better see the components and understand the structure.
To revert to this view: show subtopics under Bad Ozone, Environment and Human Health. Apply Fit to Screen,
then hide the subtopics by clicking on the quick control associated with each of these three topics.

4. Science Fair
This file should be saved with View/Quick Controls/Always Show selected, and all of the

subtopics under Student Participants, Reporters and Media, Parents and Advisors and
Judges hidden.

5. Cached Olympics web site (http://www.perseus.tufts.edu/Olympics/)
This page should be open, minimized and on the task bar. When maximized, this folder
window should open on the top half of the screen, ending just above the Ancient Greece
symbol.

6. Folder including Ancient Greece movie
This folder should be minimized on the task bar. When maximized, this folder window
should open on the right side of the screen and be about a third of the size of the Inspiration
document. Make sure computer sound is on.
7. Completed Ancient Greece document
F.

How To Use This Script
1. Do not feel compelled to read word for word
However, do communicate the educational benefits for the features you are demonstrating.
The script has been designed to give you an outline of the features and benefits that will be
covered during each step of the presentation.
2. Using the computer to present
Green italicized text throughout is meant to direct you to what you should be doing onscreen during each step.

III. Introduction
A.

Welcome!
Have Inspiration positioning diagram open on screen. Use diagram as a visual cue.
1. Hello. Thank you for coming to learn about Inspiration 8, the essential tool to help students

grades 6 to adult visualize, think, organize and learn.
2. Visual learning is the use of graphic organizers (such as the one you see on the screen) to
visually represent ideas and their relationships. Research shows that using graphic organizers
helps students succeed by building essential thinking, retention, comprehension and writing
skills.
3. Today, we are going to look at how Inspiration can be used across the curriculum and at the
powerful tools available in Inspiration that can be used to create these graphic organizers.
IV. Examples & Templates Across The Curriculum
A.

Let's begin by taking a look at a couple of examples of using Inspiration across the curriculum.
Click on the asterisk in the lower center of the positioning diagram to open the blank document.
1. Book comparison
a.

Let's open one of the 65 templates that come with Inspiration. From the Language Arts
collection, let's look at the Book Comparison template.
From File menu, select Open Template... Double-click on Language Arts in the dropdown list. Open the Book Comparison template.

b.

Imagine a student was asked to compare two books by Jane Austen - Emma and
Persuasion. They would use the template's framework and prompts to detail the
similarities and differences between the books' literary elements simply by typing
information directly in the graphic organizer.
Type in "Emma" and "Persuasion" in the Title I and Title II symbols, respectively.
This type of template guides students' analysis by providing an organization for writing a
paper on the subject.

c.

Each template is designed around a common learning standard. Educators can modify
the templates or create their own using the Template Wizard to format and save them.
Open Utility menu; show Template Wizard option. DON'T open it. Close the template
without saving.

2. Ozone
Under the Window menu in the toolbar, select Ozone.
a.

Now let's look at a completed Inspiration project on Ozone. This science example shows
how Inspiration is used for understanding concepts. Here a student has described types
of Ozone --the good and the bad--

b.

....and added more details on bad Ozone and its effects.
Click the hide/show Quick Control next to the Bad Ozone symbol. Scroll down and right
to show new parts of the Diagram. Move cursor from left to right. Open hide/show

Quick Control for Environment and hide/show Quick Control for Human Health.
c.

In Inspiration's Diagram View, symbols represent ideas, and links represent
relationships. In this example, link text is used to describe the relationship between
ideas. For instance, "bad ozone" affects "Human Health" causing "lung damage."
Use cursor to show the symbols and links you are discussing.

d.

In this graphic organizer, pictures, such as this lung, add visual meaning and increase
retention, particularly for visual learners.
Point out lung symbol.

e.

By creating a graphic organizer such as this to represent scientific information, students
better comprehend the material and concepts. It also helps educators identify where
students may have misconceptions.

3. Science Fair
Close the Ozone example and switch to the Science Fair example by selecting it from the
Window menu in the toolbar. (This file should be save with View/Quick Controls/Always
Show selected. With Quick controls (hide/show) for Judges, Student participants, Reporters
and Parents saved as closed.)
a.

Inspiration is also a great planning tool for students, teachers and administrators. For
instance, this graphic organizer was created to organize and disseminate information
about a Science Fair.

b.

Each type of participant is identified. And the information each participant needs is
detailed.
Open hide/show Quick Control for Judges, Reporters, Parents and Student
participants one at a time. Scroll up to show all of Student participants.

c.

This was used as a checklist of needs as well as the organization for a website. Using the
Site Skeleton export in Inspiration, each symbol becomes a web page with the links
indicating the navigation between the pages.
Open File. Click Export. Click Web Pages tab. Point to symbols and links in preview
pane. Click Cancel.

V.

Demonstration
The examples we've looked at so far show the educational power of Inspiration in language arts and
science.
Close the Science Fair example and open the Starter screen, by selecting File, New.

Now let's start a new social studies assignment together.

From the Starter screen, open a new document in Diagram View.
A.

Starter screen
1. We will start from the Inspiration Starter screen where we can begin a new project in
Diagram or Outline View or with a template, as we did with the Book Comparison
assignment. We can also open and expand upon existing files. Additionally, we can access
training and teacher resources from the Learn to Use section, which we'll discuss more later
in this presentation.
Point to the options as you speak.

B.

Diagram View
1. Main idea
We'll begin in Inspiration's Diagram View. Imagine we are students doing a report on
Ancient Greece, so we'll make that our Main Idea.
Type "Ancient Greece" into the Main Idea symbol; make sure the symbol remains selected
when you're finished. Zoom in once.
2. Create tool
The assignment requires us to include information about Government and Economy. We'll
use the Create tool on the toolbar to add symbols that represent these topics.
Select Ancient Greece; use the Create tool to create a new symbol to the upper left and type
in "Government;" select Ancient Greece again and use the Create tool to create a new
symbol to the upper right and type in "Economy."
3. RapidFire
a.

We can easily brainstorm a few more topics by using the RapidFire tool, which allows
us to quickly add ideas. We can add ideas With or Without Links. Using RapidFire
without links gives us the option to brainstorm first and identify relationships later. The
lightening bolt indicates RapidFire is now active.
Select Ancient Greece; click on the drop down menu on the RapidFire tool and select
Without Links to activate it.

b.

We can add another topic area, such as "Geography" by simply typing the words then
hitting the return key. A new symbol is then created. Additional topics we can include
are "Time Period" and "Farming." We can literally add thoughts as fast as we can type.
Type each topic as you say it; hit enter after typing each topic. (Note to presenter: make
sure you enter these topics in the order listed here.) Click away when finished typing.

4. Creating and changing links
Now that we've added these new topics, we can link them to the appropriate ideas in our

graphic organizer by using the Link tool.
Link Ancient Greece to Time Period and Geography.
As we view the graphic organizer, we realize Farming should be a subtopic of Economy so
we can drag it next to the Economy symbol and link them together.
Drag the Farming symbol to the right of Economy and link them together.

5. Using the Symbol Library
a.

Open the Symbol Palette.
As we saw in the Ozone example, using pictures or graphics as symbols is a powerful
way to visually represent ideas. Inspiration includes a collection of over 1,000 symbols
in its Symbol Libraries.
Click on Libraries in the Symbol Palette to show list. Drag cursor down the list to
highlight the variety of symbols.
With an Internet connection, students may also access Inspiration Web Resources to
browse a safe, web-based catalog of more than 1 million symbols!
Finding the perfect symbol in this robust collection is easy - we can simply perform a
search for a specific word or phrase. Let's search for an image of money to represent
economy.
Type "money" into the search box and hit enter or click on the Find button, which is the
icon in the lower right hand corner of the Palette window.
Once we find a symbol we like, we can simply insert it in our graphic organizer.
Select the Economy symbol. Now click on the image of cash and it will change the
Economy symbol. Close the Symbol Palette.

6. Drag-and-drop
We can also use drag-and-drop capabilities to easily add more information to our graphic
organizer.
a.

For this example, we'll create a reference to a web page about the Ancient Olympics by

dragging-and-dropping its hyperlink right into our diagram.
Open cached Olympics web site from task bar. Click on the icon to the left of the url in
the address bar and drag it into your diagram window, creating a new symbol. Position
it below and to the right of "Geography."
b.

We can also drag and drop in other types of files, such as Word and Excel files and
PDFs, and Inspiration 8 will create a hyperlink to them. This gives us a simple way to
add information, gather research and keep all of our work and materials together.

7. Adding Multimedia Video & Sound
Students can also easily add multimedia, such as QuickTime movies and .mp3 files, to their
diagrams to enrich their projects and make them more dynamic. Let's replace our Time
Period symbol with a video clip about living in ancient Greece, courtesy of unitedstreaming.
We can also drag-and-drop this file into our diagram.
Maximize folder that includes the Discovery School Channel video
"Living_in_Ancient_Greece.mov." Drag and drop "Living_in_Ancient_Greece.mov" into the
Time Period symbol, so that the video clip itself becomes the new symbol. Minimize or close
folder if necessary.

a.

We can play multimedia files directly from the diagram to stay in one application, which
saves us time and keeps us focused. We just press the camera button to play.
Select the video symbol & press the camera button to play. When open, you may need to

adjust the contents on the screen by scrolling to see the video screen. When ready to
move on, click the pause button and then click away from the video to close.
8. Notes tool and Note Quick Control
As we continue our research, we are likely to find a lot of detailed information. We can add
this information to the diagram with the Notes tool.
a.

We'll select the Government symbol, then click the Note button. And enter the
information.
Select the Government symbol; click the Note button on the Diagram toolbar. Type "The
Greek city-state was an independent political unit."
We can add up to 15 pages of notes to each symbol.

b.

A Note Quick Control appears to show us when a note exists for that symbol. We can
click on it to hide or show the note.
Close the Note by clicking the Quick Control.

C.

Switching to Outline View
As we create a diagram, Inspiration simultaneously builds an outline of the same information and
relationships. We'll switch over to Outline View and take a look. This traditional format helps
students quickly prioritize and rearrange their ideas for projects.
Make sure the Ancient Greece symbol is selected; click the Outline button to go to Outline
View. Zoom in once.
1. The Topic tool
Here we can continue to add information and change relationships. To add a new topic, we
simply click the Topic button and enter the name of the new topic, "Community."
Click the Topic button to create a new topic and type in "Community."
2. Word Guide
The Word Guide, a combination dictionary and thesaurus, can also be opened from the
toolbar at the top of the screen. It allows us to look up a word and see information displayed
just as it would appear in a dictionary: words in an alphabetical list with pronunciations,
variations and parts of speech.
Click on "Community" and then click on the Word Guide button in the tool bar. Enlarge the
Word Guide by dragging out its lower right corner, if necessary.
a.

Each definition of the word is specifically matched to synonyms that share that meaning,
helping us to precisely select the word we want.
Click/scroll through the different definitions and synonyms. Show the opposite is also
true (click on a synonym and showcase how it also highlights that word's specific

meaning,)
b.

To replace a word with one we would would prefer to use, we simply select it. For this
example, let's replace "Community" with "Society."
In the second group of synonyms, find the word "society." Click Replace.

c.

The Word Guide helps students build their vocabulary and is also available in Diagram
View.

3. Moving topics in Outline View
We can reorganize information by using the Move Left and Move Right buttons in the
toolbar or by dragging and dropping. For instance, The Ancient Olympics should be a
subtopic of Society, so we'll drag The Ancient Olympics up and over to the right, then drop
it. Guides become available to help us place our topic exactly where we want it.
Select The Ancient Olympics. Make sure your cursor shows the arrow instead of the
pointing finger so that you don't open the link instead of selecting the topic to move it. Drag
The Ancient Olympics up and to the right so that it becomes a subtopic of Society. Return to
Diagram View.
D.

Returning to Diagram View
Back in Diagram View, we see that the changes made in Outline View are reflected. We can see
here that Society is now a new topic and The Ancient Olympics is its subtopic.
Point to Society and The Ancient Olympics.

1. Arrange
Select the Ancient Greece symbol again.
As graphic organizers get larger, students can use the Arrange tool to format their diagrams
as various types of graphic organizers.
Click on the Arrange drop down button on the tool bar, select More.
There are a variety of arrangement options to choose from. The preview window allows us to
see how our diagram will look depending on the options we select.
Select some of the options and point out how those affect the diagram arrangement with the
dynamic sample on the right.

We'll select the Tree type of arrangement for this example.
Click on Tree, Down and Standard options in each respective category and click OK. Close
the file without saving.
E.

See completed Ancient Greece document -- Transfer tool
Under the Window menu in the toolbar, select Ancient Greece. Don't move or change anything
in this completed file!
1. Now, let's jump forward in the research and writing process. Here is what our more
complete "Ancient Greece Report" Inspiration document might look like.
2. We can see all the new information has been organized and that convenient formatting tools
were used to change fonts and symbol colors. Formatting differentiates information and is
helpful when using Inspiration for presentations.
Move mouse cursor over formatting toolbar.
3. In Outline View, our notes have become more complete.
Click on Outline View.
4. At any point in the process, we can save or print the document. If we want to finalize the
project in a word processor, we use the Transfer tool. When we click on the Transfer button
on the toolbar, a Transfer Options dialog box opens and we can select to transfer our outline
with or without the diagram, as well as which topics, subtopics, notes, type of outline
prefixes and indentation formatting we want. The Transfer Options preview window allows
us to see what our finished document will look like.
Pause the mouse over the Transfer tool, then click. Click on the Transfer button on the tool
bar. Point out the options. Uncheck some of the options and point out how those changes
affect what will transfer with the dynamic sample on the right.
When we click OK, our project will automatically transfer to our word processor.
Click OK. If prompted, choose Microsoft Word in the dialog box.
Close Word application. Close Inspiration document. Do not save changes.

F.

Inspiration Web Resources
Let's return to the Starter screen and look at some complimentary resources available to students
and teachers when using Inspiration with an Internet connection.
Select File, New and show the Starter screen.
1. Additional Templates
There are 65 templates that come with Inspiration and an additional set of more than 170 that
are available via Inspiration Web Resources when you are connected online.
Point to the Templates button. Do not open.

2. On-Demand Training Videos
Also available through Inspiration Web Resources, students and teachers can learn how to
use Inspiration and complete projects efficiently with on-demand, step-by-step training
videos in the Learn to Use section. There are videos for the beginning user who needs to
learn how to create symbols and connect them with links, to videos for more advanced users
who are ready to do things such as create Custom Libraries.
Click on Learn to Use and expand Training Videos folder. Select Customize Inspiration,
Large, and play a/part of the Create Symbol Libraries.mov training video to demonstrate.
Upon completion, collapse Training Videos folder.
3. Curriculum Packets
(Note to presenter: For computers not connected to the Internet, you should see an "Acids
and Bases" folder saved in your Curriculum Packet folder. This is to be used to show the
Curriculum Packet when you do not have an Internet connection during your presentation.
See II.C. above for preparation instructions.)
In addition to the training videos, more than 50 standards-based Curriculum Packets are
available through Inspiration Web Resources. These comprehensive units of instruction for
the high school curriculum were developed by educators across the country and will help
develop student learning in Language Arts, Science and Social Studies. Each Curriculum
Packet includes: a unit overview, templates and exemplars of student work.
Open Science folder, then the Acids and Bases Curriculum Pack folder.
When accessing a Curriculum Packet for the first time, we can download the unit and all of
its corresponding files onto our desktop computer or network. We simply have to save it in a
file of our choice. From that time on, we can access these Curriculum Packets like we would
any other Inspiration document we've saved on our computer.
At the prompt, click OK, then click Save at the next prompt.
Open Unit Overview file.
The Unit Overview provides an overall summary of how the unit may be taught and acts as
the portfolio where supporting files are kept.
(Note to presenter: If you handed out Inspiration Software's Product Resource Guides to
your audience members as they came in today, you may direct them to page 15 to get a
closer look.)

As an Inspiration file, teachers can see the overall scope of the unit plan, applicable grade
level, class time duration and the standards covered with the resources provided here. The
Unit Overview also provides direct access to its supporting templates and exemplars.
Point out each element as you discuss.
Exemplars represent completed templates and provide a benchmark for determining highquality student work. These may be used as rubrics, answer guides or study guides.
Open the Types of Acids and Bases exemplar. Close file.
G. Wrap up Demo
View Inspiration positioning diagram.
In this demonstration, we've seen how easy it is to get started using Inspiration, how Inspiration
can be used across the curriculum to improve assignment outcomes, and how Inspiration helps
students succeed by strengthening important thinking and learning skills.
H. Additional good information to share
1. Inspired Learning Community™
Also, now available is the Inspired Learning Community, a great new website where you can
find and share ideas on how to use Inspiration, InspireData and Kidspiration! Visit
www.inspiredlearningcommunity.com to join the community today. It's free to join and
participate!
2. Flashes
If you've enjoyed seeing how Inspiration is used, you'll want to sign up for Flashes, the
official newsletter of Inspiration Software. You can sign up for it on the web site at
www.inspiration.com/newsletter.
3. The Thinking Classroom: Using Inspiration® to Meet Curriculum Standards
This book is designed to support teachers as they help students develop their critical thinking
strategies. Each of the book's six sections includes an overview of a key cognitive strategy
and its application in the major curriculum areas of language arts, science and social studies.
Find more information on this Inspiration resource at www.inspiration.com/lessonplanbooks.
4. Additional Curriculum Integration resources
For more information on curriculum integration, visit www.inspiration.com and click on
Curriculum Integration to find practical examples, lesson plans and real-life classroom

stories, as well as links to standards matches for more than 35 states and information on
using Inspiration with leading education textbooks.
5. Purchasing information
Inspiration comes on a hybrid CD-ROM for Windows and Macintosh in single copies and
volume licenses for schools and districts. Volume licenses also have Teacher Take Home
Privileges. This means that teachers can have copies of Inspiration installed at home for
planning and training purposes.
6. Company Contact Information
9400 SW Beaverton Hillsdale Hwy, Suite 300
Beaverton, OR 97005-3300
www.inspiration.com
sales@inspiration.com
503-297-3004 or 800-877-4292
503-297-4676 (Fax)

